This paper describes objective technical results and analysis. Any subjective views or opinions that might be expressed

in the paper do not necessarily represent the views of the U.S. Department of Energy or the United States Government.
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Novel Approaches to Pass Data
Between TestStand and LabVIEW




Outline

- Pass by Value

- Pass by Reference

= Clusters

- Objects

= Variants

= Variants with Attributes
- Images

- DVR’s

- Queues

- Events
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Standard Variable Options

[FIE FUEE g | TR W T Ve [ A Ty

II Insert Local > Number

um :
" Cut Ctrl+X o
a Copy Crl+C Boolean
‘. Paste Ctrl+V Object Reference
ot Delete Del Container
= Copy Value Type > Error
bl 4 r e ) :::ession
NI_TDMSReference
VI
LabVIEWAnalogWaveform LabVIEW
LabVIEWDigitalWaveform
LabVIEWDigitalData
e no steps selected. LabVIEWDynamicData
LabVIEWClusterArray
LabVIEWIOControl
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Basic Structure of LabVIEW VI's in Demo

- TP Wy

= Main (5)

%) Message Popup NameOf(Step)

{55 Cluster Out Action, Cluster Out vi
@ ) Message Popup NameOf(Step)

- Cluster In Action, Cluster In.vi

EZ) Message Popup NameOf(Step)

<End Group>

Properties 53 Textand Buttons E3) Options &3 Layout
Title Expression: NameOf (Step)

Message Expression: Number of ' + Parameters. DemoString + 's- "+ Str(F DemoNumeric

R #tan | shal Evnmesinne (1 Inlshalad ki #tane ams hiddan)
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- [E Locals (Clusters’)
+ [11] ResutList it
+ [H Cluster
<Right click to insert Local>
- B Parameters (‘Clusters’)

DemoPath "C:\Users"

[t23) DemoNumeric 6
DemoString “dog"

+ [01] ArayOfDemoString iz
<Right click to insert Parameter>

Array of Result[0. empty]
Cluster_Out (Container)

String (By reference)
Number (By reference)
String (By reference)

Armray of Strings[0..9] (By ...
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Ll

o
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Basic Structure of TestStand Sequence in Demo

CIUSter Out: uNoError 'H 1
1 DEMO
?I.US
DemoNumeric| o6t | L H DemoNumeric CI USter.
DemoString |[Lab DemoString
Array of DemoString | [abe X Array of DemoString Cluster Out DemoCluster
DemoPath A Duck J— DemoPath
2
error in (no error) é} S error out

Cluster In: EI No Error 't]

Demanumeric |DemoNumeric
TS DemoString DemoString
Cluster | ¢ :
el Array of DemoString Array of DemoString
DerpoPath DemoPath

error out

error in (no error) é
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Pass by Value

- Parameter value passed into subsequence does not get passed out

- w—— ey

=) Message Popup NameOf(Step)
@ij PassByVal Call PassByVal in NI_Week_Dem... e Pro or Con: Variable Of Calllng
%) Message Popup meOf(Step)
_________ ) PassByRef Call PassByfeiialyl Week De.. Sequence stays the same
i %) Message Popup NameOf(Step)
Parameter Name Type Log Default  Value How Passed C
DemoNumeric Number O [  Parameters.DemoNumeric | by value
DemoString String ] [l Parameters. DemoString SNV | by value
= Main (3)
Su bseq uence. St Change Dogs to Cats Parameters. DemoString = "Cats”
J&) Increment Number Parameters. DemoNumeric = Parameters. DemoNumeric +1
&) Message Popup NameOf(Step)

NATIONAL <End Group>
"7INSTRUMENT$" g



Pass by Reference

- Default setting in TestStand for all variables

- w—— ey

=) Message Popup NameOf(Step)
%;Zﬁ‘f’:,om s «  Pro or Con: Variable of Calling
_________ P) PassByRef mame__ Call PassByRef in NI_Week_De... Sequence is updated

&= Message Popup

How Passed

Parameter Name 3
DemoNumeric Number O [  Parameters.DemoNumen

S | | by reference
DemoString String [l [l Parameters. Demo String &) by reference
Sub . = Main (3)
bsegquence. i fiv Change Dogs to Cats Parameters. DemoString = "Cat”
St Increment Number Parameters. DemoNumeric = Parameters. DemoNumeric +1
&) Message Popup NameOf(Step)

NATIONAL
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Clusters

+ emorin {no emor)
+ Cluster Out

+ emor out

DemoCluster
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Need to “Create/Update Custom Data Type from Cluster”
Good for passing data in Sequential steps

Complex Cluster:

‘1§ Create/Update Custom Data Type from Cluster

Use this dialog box to create or update a TestStand custom data type based on VIEW cus
(®) Create a New Type (O Update an Existing Type
Type Name: [ DemoCluster
Force Exact Match
LabVIEW Label TestStand Name  LabVIEW Type  TestStand Type
DemoNumeric DemoNumeric Number (DBL) Number
DemoString DemoString ASCIISting v Sting
Amay of DemoSting  Aray_of_DemoString 1D Amay (ASCII € v Aay of Strings
DemoPath DemoPath Path Sting
DemoQueue out DemoQueue_out  Number (U32) Number
Number

data value reference « data_value_reference Number (U32)
Object in TestStand Iy Object_in_TestStand Object Reference  Object Reference

Create Custom Data Type In File:

[NI_Week_Demo.seq- <Selected Sequence Fie>

Help

Tﬁ Create/Update Custom Data Type from Cluster

Use this dialog box to create or update a TestStand custom data type based on the LabVIEW duster you select.

(®) Create a New Type Update an Existing Type
Type Name: [ cluster_out
Force Exact Match
LabVIEW Label TestStand Name LabVIEW Type TestStand Type
DemoNumeric DemoNumeric Number (DBL) Number
DemoString DemoString ASCII String v Sting
Aray of DemoString  Amray_of_DemoSting 1D Amay (ASCII ¢ v  Amay of Stings
DemoPath DemoPath Path String
Create Custom Data Type In File:
NI_Week 0.seq- <Selected Sequence File




Clusters Continued
» Custom Data types appear in Insert -> Type-> Custom Data Type
NN | Pro’s:

o cunx | Sting « Data easily visible in TestStand
tod  Copy Cti«C e « Custom data type can be used easily in
oCont Paste Cirl+V Object Reference b5 X
vl Bis b | Container | multiple places
00 Copyaue Tpe 5 +  Better to use Custom Data Type then
View > Aok : creating a container with variables
i ath

Expression « Changes to a Custom Data Type

PLENERIGCe will populate throughout sequence

i >

LabVIEW >

viia
- [ Locals (Qlusters’)

Con’s: "

« If using just a container and you change the cluster
then you must change the container everywhere

* Not very flexible if still making lots of changes in
Cluster/Type def.

DemoNumeric
DemoString

+ @ Array_of_DemoString @
DemoPath

ik fo insert Local>
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Objects

= Object Oriented Programming fully supported in TestStand
- Ok for passing data in Sequential steps

&% Step Settings for Object Out - [ Locals (‘Objects’)

Properties (@ Module + [11] ResultList ik | Amay of Result[0..empty]
Call Type: < Class Member Call v > Nothing Object Reference
Project Path:

(Optional)
Class Path:

(No file specified

Object in TestStand Ivclass >

C:\LabVIEW 2017\NI week Demo\Object in TestStand Ivclass Pro’s:
S _ «  Supports Dynamic dispatch
Parameter Name Type InOut Log Default Value . Encapsulates Data
DemoPath Path in O O Parameters. DemoPath . . .
S — - = R Cannot accidentally change data in
SN scisc v O[] Porameton Domosing TestStand _ _
Aray of DemoSting [0.... 1D Amay (AS... v in 0 []  Parameters ArayOfDemoSting » Good for passing data in Sequential steps
+ emorin {no emor) Container T8 in ] [ Con’S:
Licctin TestStand vol... Object Reference  out 0 Locals Object « Can not see what is contained in object
+ emor out Container & out ] Step.Result. Emor

during execution

NATIONAL  Can not change data in TestStand
"7INSTRUMENT$" 9



Variants

- Initially, Create an Object Reference or Container

<Right click fo insest Locab
- Parameters (Variants')
<Right click fo insert
- i@ FileGlobals ('NI_Week_
<Right click fo inset File Glo.
+ @ StationGlobals
+ [77] ThisContext
+ @ RunState
+ B Step (Variant In')

Param

<Right click to insert Station Global>
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Insert Parameter
Cut

Copy

Paste

Delete

Copy Value

View

Crl+X
Ctrl+C
Ctrl+V

Del

>

Number

String

Object Reference el
Container

Be,
b

- Parameters (Variants')
[=] Variant Nothing Object Reference (By re... &5

<Hight click fo inrsert Paramefer>

@ aVariam In )Ction, Vanant In.vi
E=) Message Popup NameOf(Step)
<End Group>
# Cleanup (0)
V4
& Step Settings for Adding P ers.Variant to StationGlobals.Variant

>roperties /¥ Expression

Expression:
StationGlobals.Variant = Locals.Variant
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-,

Variants Continued - @

23] [0] 77

(123 (1] m

= 2 114

. . . . 23] 131 101

* During runtime Container/Object Reference changes to e 00
“Array of Results” 5 0

« Variant Values can only be seen in variables tab during B =

execution
* Variant created in StationGlobals will retain values afte
run for trouble shooting

o (-

16 ‘{:' L:’ {:' L:: SR SRR

() Variants - NI_Week_Demo.seq [9] Pa... g]

Steps ; - ?
Step Description ss ?
® Setup (0) > =
= Main (5)

&%) Message Popup NameOf(Step)

te2 Variant Out Action, Variant Out vi "C:\Users\Scott"

e B Message Popup NameOf(Step) ¥ @ 7 L
i Variant In Action, Variant In vi + (1] [8] !
+ [@ e L
Numeric Letter ! @ [10] ?
W7 NATIONAL = o \‘“ 5 @, 3 B e "C:AUsers\Scatt”
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Variants

Pro’s: Con’s:

- Works well for sequential steps - Can be easily overwritten

- Provides some idea of data contained - Can be confusing when working with

- Very flexible if you are still large clusters in the variant
changing/deciding the data to pass - Can be confusing when passing
between steps around strings
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Variants with Attributes

- Create String Variable
- [ Locals ('Variants with Atributes’)

+ [11] ResuttList icE:| Amray of Result[0..empty]
B VariantsWithAttributes String L5

- MUST select Binary String

T SV N I S g A Li ni LJ [l | S
data string out out ] Locals.Variants With Attributes |
+ emor out Container 8 out ] Step.Result. Emor k- IV
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Variants with Attributes

= Must Use “Flatten to String”

= Don’t use “Variant to Flatten String”
- The help says this function strips out all variant attributes.
Guessing this is what TestStand is Leveraging under the hood

o ] o @/gr[—

“ . B Lu
DemoNumeri& | | DemoString [771 | Array of DemoString A DemoPath st [
{31 T 1] L _ﬁ_l O 7 71 71 - ﬁ.l »
Label Text? Label Text? Label Text? Label Text?

Value » Value Value Value °*

Efﬁi]]DemoNumeric

[
[ : DemoString
T | — g babe] [Array of DemoString
=) : [=) [=) 82 [=} z
DemoNumeric ™} .—J§é DemoString { e @é Array of DemoString || ] @é DemoPath [ g I@é [l DemoPatth
(71 71 = | (71— 1) 9 b (77—} ol M- (71— 1 s L] —— i d5at | error ou
Label,’l'ext’-'-""""""j ‘ Label.Text"‘j Label. Text" Label. Text? 7
alue Wr—m™@8¥ Value Value Value Y
¢ NATIONAL
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Variants with Attributes

‘ | ) Varan ] Amay of Containers(0.3]  [35¢

"E@=3DJU2100h YLJA 1>3@0DL::X1@6SJ131H<n0Hk B3WoEU@EC3Bee > Ze TDH=FUQ=gocl_@ImU@_JZ=A¥_4c_7IN<ba338SLc4d nRGFbFX\4ZFbLbohK06S " "FEAM43G]=gNabA489H35416G57:UI0OAIR:6bVO=XEk 2D\ Y5H?_[d">J8UUFCIQe "bMREUH X38K>0cXJBOUGX PmZYi""USGY963_\>=cC=UISTJB\GF
[C>kiR8XGRbDGgZAE] 18WYgb Uj:d==2mP Yo SMWKJXJJIMWBICWY\"0\V6]:PS02> j0iPn TBUS<BE:\ol3@_4QN YfSHm'=2Zko 1V5k CnGmmcCfCH 58f8aniZ2h XRoG > EhO 2 AIMcP7J8A=<"
I | =< -

oo

Pro’s: Con’s:
- Works ok for sequential steps - Forget to change from ASCII string to
- Very flexible if you are still Binary String

changing/deciding the data to pass - Previous Variant stuff does not work.
between steps - Strips the attribute

- Handy for Variant Attribute Look up - Long String of junk
tables
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Images

* Need NI Vision
* Could only get the LabVIEWIOControl to work
* Not sure why the Container did not work

k- RV o=
Parameters.Image S | <N

LY

Step.Result. : T ,
- E'TTExpected Container or LabVIEWIOControl, found Object Reference.

Value

|| |f(f) v
Locals.ImageContainer S|
Step.Result.Emor o e

The type of 'Locals.ImageContainer’ does not match the LabVIEW cluster ‘Image Out’, or cluster passing is disabled in the type definition of ‘Locals.lmageContamer‘.h
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DVR’s

 Pass DVR as a Number
« Pass Reference to DVR as a Number S Exp.ected Number, found Object Rc—ference%
« Pass DVR as a Data String like variant attribute

Parameters. DVR

Pro’s:
« Can be nice for large data sets
Con’s:
I S— . Fgrget to ghange from ASCII string to
+ [T1) ResultList i Aray of Resut[0. empty] Blnary Strlng
mow [ Nmber &« Long String of junk
DataValueReference Ref 0 Number Zﬁ'
DataValueReferenceDataString String e
data value reference ref out Number (U32) in | | <The expression cannot be empty > ) |
data value reference data string v in ] ] )
+ emorin {no emor) in J - S8 v

~ " oa
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Queues

Pass Queue as a Number
Pass Reference to Queue as a Number

Pass Queue as a Data String like variant attribute

 Pass Queue Name

TNoError ~P]

S | -

uuuuuuuuuuuuuuuuuuuu

DemoString e Demostring
Armay of DemoString el Arvey of DemShiing
DemoPath (=¥ . DemoPath
. [DemoQueue} {Bik]|Queue Name out
[Scott}-o [omo
fscot] e + = TReitium | 5 JDemoQueue Ref out
E il Sijerror out

Number of Elements to Enqueue [TE28-

uuuuuuuuuuuuuuuuuuu

f)

Parameters Queue

=
Expected Number, found Object Reference.jj »
Parameters. T ha® 4 J

- [ Locals (‘Queues’)
+ [(1] ResultList ik}
:
QueueName
QueueRef 0

— — No Error ]
77 {No Error ~P] o Eror <Hf
bueﬁur,:l Sk
calk i N -#9BL ]| Dy i Q o »36L 1 DemoNum: - %55L] DemoNumeric
e I~ e emoStrin J[Demostring
e DemoString babe ||D l——t e QueueRef in[EH—- o ng 1 Array of DemoString
Array of DemoString #av<] |Array of DemoString Lo [Amay o , s a5 ‘ D ¥=1|DemoPath
.. DemoPath == 1|DemoP: = (o emor Rt S TypRef (sict) yd %3] error out
errorin =ot] error out [ Ve o

{$5T] error out

error in (no error) [ feeeceeed et
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Queues Continued

Parameters Queue RiE RV

‘o
Pro’s:
Expected Number, found Object Reference.

« Can store multiple pieces of data S—— Ty y
« Can be from multiple steps
« Can then be processed in a single step
- [ Locals ('Queues’)

Con’s

* Must make sure you enqueue enough elements 3 13
otherwise code will hang waiting to dequeue °
element QueueName

. . QueueRef 0
« Can be confusing where elements are enqueue if 2
you have many asynchronously running VI's
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' INSTRUMENTS'



Events

« Cannot pass data between steps in traditional sense
« Events are not like queues. Once the event fires if nothing is a registered
listener then the data is gone.

Must have a Asynchronously running VI registered to listen to event.
« Can have as many clones running as you would like
All will simultaneously receive data.

Parameters. Event

Step.Result Emor

Expected Number, found Object Reference.

user eventinCE
Rt N
il User Event Ref In[CE—{8 < TypRef (stict) 5] [5 7 RegE " S —
Value ) User E —
] B3 Reg b 54— l JEae ) D
$ et TlArmay of
L‘_‘l ! Use Event Out Event Regi Refnum In (58 ~{¥=1|DemoP:
oUR < e
rrrrrrrrrrrrrrr = St
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Asynchronous Dynamic Events

- Can easily do One to Many

2nd' T[No Error ~p[’
. 1] Panel Close b
5% Reg bvents Z iz
ro e < o P UserEvent v Source
—a g g Type H & %9501 DemoNumeric
H ] Time =]l
error in (no error) [Fik "3 VI (strict) ul b2 1] errOr OUE ve Elrey o e
FP.Open = ]|Demol

b Activate exror in (no error) (TR} F= VI F= Vi 5
. S‘at nzm! : FP.Behavior @ Default FP.Behavior

i r—
o Standard ] = o =

3rd- - T

.
- o Get <] o
: ron

DemoNumeric | 060 B2 moN
: crilabe DemaString
Array of D Array of DemoString
D DemoPath
4 ®) error out
error in (no error) [E231 6 t =5
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Conclusion

- Can put almost anything into an Object, Cluster, Variant or Data String and
pass it between steps

- LabVIEW fully supports Object Orientated Programing

- Queues can be used, just make sure to enqueue enough elements

- Dynamic Events can easily send messages/data to many VI's simultaneously
- Variants work well for sequential steps or Dynamic dispatch

- Varying abilities to view data in TestStand
1. High — Cluster
2. Medium — Variant
3. Low — Object, Data String, Queues, DVRs,
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Title
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Time
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Nick Butler

Nick Butler
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Overall Quality

- select one - ’ take the Su rvey-
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- select one - v |

Relevance to published title and abstract

- select one - Y|
Nick Butler
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